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Introduction 

The best way to build your comfort level with your Brain is to build one yourself—
with your very own hands. This guided tour will walk you through the basics, 
pointing out items of interest along the way. There’s no need to take notes and 
you’ll never get left behind, because you’ll be going at the most strategic pace—
your own.  

  

During this tour, you’ll be asked to enter specific information to make it easier to 
refer to items and areas as the tour proceeds. Naturally, when you’re on your 
own, you’ll use your own ideas to create Brains that reflect your thinking. 

Here are the sign posts you’ll see along the way: 

 
Enter here—the startup action for this phase of your guided tour 

 
Point of interest—take out your virtual camera 

 
Tip—where you can find more details about this step your guided tour 

 
Take five—this is a good place to take a break if you want one 

 
Exit here—this marks the end of your guided tour 

 Let’s go! 
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A Guided Tour of TheBrain 

Part 1: Explore the Brain Window 

Itinerary: You’ll start up TheBrain, create a new Brain, and tour through the 
components of the Brain window. 

 

Start up TheBrain, unless it’s already running. You can select TheBrain from the 
Start menu. 

 

 
Figure 1. Starting TheBrain 

Start Up 

When you start, you must log in to your Brain account. This enables integration 
with any subscriptions you may have. The Welcome dialog box provides the 
ability to a sign up for an account and also provides a link for choosing to not 
connect to any server. 
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Figure 2. TheBrain 7 Welcome Screen 

If you do not have a Brain account, click the Sign Up button to create one.  If you 
do not wish to run a registered version of TheBrain, click the Do Not Connect to 
the Server link to run the free version of TheBrain. 

1. Click the New Brain button on the welcome screen (or click the File menu, 
then click the New Brain command).  

2. In the empty field, type: Tour 

 
Figure 3. New Brain Dialog Box 

 Notice that the Location field displays the path of the folder in which your 
Brain will be created. You can use the Browse button to change the 
location, if necessary. 

3. Press the Enter key or click the OK button to finish creating a new Brain 
named “Tour.” 
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 Your screen should look similar to this: 

 
Figure 4. The Parts of the Brain Window 

TheBrain creates your first Thought for you. It has the same name as your Brain 
(which you can change later if you want to). Since it’s the only Thought, it’s also 
the “active Thought”—the Thought that’s currently selected. 

 The Brain Toolbar 

 
Figure 5. TheBrain Toolbar 
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1. Point at each one of the buttons in the Brain toolbar so that you see a brief 
explanation in the pop-up tool tip. 

2. Click the Add Brain button to add “Tour” to the toolbar. Now you’ll be able 
to return to this Brain when any other Brain is open. 

 The Brain Tools 

 
Figure 6. A Note in the Notes Tab 

1. Click in the empty white space of the Notes tab in the Tools window, then 
type: My tour of PB. You’ve just created your first Note, which is 
associated with the “Active Thought”—Tour. 

  

There’s no need to save Notes, even if you activate other Thoughts or close your 
Brain. Although your Notes are saved automatically, you can click the Save 
command on the File menu or press Ctrl-S to save if you want to. 

2. Click any of the other Tools tabs if you want a quick peek.  

 Tip: See the section beginning on page Error! Bookmark not defined. for 
details about working with the Notes tool. 

  Window Behavior Options 

1. Click the Window menu and note what the current selections are so you 
can return to them later if you want. 

2. Select one of the auto-hide options, then click outside of the Brain window. 
Notice that the Brain window is now hidden from view. 

3. Click the Brain button to reactivate your Brain. The button will be located 
on whatever side of the screen you selected via the auto-hide option. 
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Figure 7. Display TheBrain 

4. Click the Window menu, then click the Float command. Notice that now 
you can minimize, maximize, or restore the Brain window using standard 
Windows’ techniques. 

 Tip: See “Error! Reference source not found.” beginning on page Error! 
Bookmark not defined. for details about controlling the behavior of the Brain 
window.  

Part 2: Create New Thoughts 

Itinerary: You’ll create a single Thought, multiple Thoughts, a Thought from an 
existing file, and a Thought “pin,” and modify the relationship between two 
Thoughts. 

 
Your Tour Brain should be on the screen, as you left it in Part 1. 

 

1. The three circles surrounding the Tour Thought are called “gates.” The 
bottom circle is called the child gate because it provides a gateway towards 
creating a child Thought. Drag the mouse from the child gate down a short 
distance, then release the mouse button. The Create Child dialog will 
open. 

 Tip: If you prefer not to drag the mouse to create a Thought, right-click the Tour 
Thought and then click the Create Child command on the context menu. 

 
Figure 8. Dragging from the Child Gate 

2. In the empty field, type: PB Buddies 

 This Thought will organize Thoughts about people you’re going to talk to 
about how they use TheBrain, so you can share experiences. 
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Since “PB” isn’t a standard word, you’ll see a red squiggly line under it. Spell 
checking is active by default. You can ignore the word or add it to your Brain’s 
dictionary by right-clicking it and selecting the option of your choice. Spell check 
preferences are explained in the “Error! Reference source not found.” section 
on page Error! Bookmark not defined..  

3. Press the Enter key (or click the green button showing the check mark). A 
“pulsing” circle appears around a new Thought for a few seconds, 
highlighting it for easy visibility. Your Tour Thought now has a child Thought 
named “PB Buddies.” 

 Creating Multiple Thoughts at Once 

You can create more than one Thought at a time by typing a semicolon to 
separate each Thought. 

1. Create four new child Thoughts for Tour, all at the same time. To begin, 
drag Tour’s child gate down a bit, then release the mouse button. 

2. In the empty field, type: Tips; Reminders; To-Do; New Brain Ideas 

 
Figure 9. Multiple Thoughts at Once 

 Tip: The semicolon (;) between each Thought name tells TheBrain that these are 
separate Thoughts. 

3. Press the Enter key (or click the green button with the check mark).  

 Create a Thought by Dragging and Dropping an Existing File 

You can create a Thought by dragging a file from the desktop or from your file 
manager (such as File Explorer on Windows or Finder on a Mac). The new 
Thought will have the same name as the file (minus its extension) and it will 
automatically have the file as an attachment. You’ll learn more about 
attachments in the next part of this tour. 
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1. Choose any file, from your desktop or from any other location. Your original 
file will not be affected by being moved into your Tour Brain―you’re just 
creating a shortcut. 

2. Size the TheBrain window so that you can also see either the portion of the 
desktop containing the file you’re going to use or the window in which the 
file is listed.  

3. Drag the file into the Plex. 

 
Figure 10. File Dragged into Plex Becomes a Thought 

 The new Thought will appear in the Plex and it will include an icon that 
represents the type of file. Any time you click this icon in the Plex, the 
related file will open. 

   

If TheBrain is in auto-hide mode, dragging the file to the Brain icon opens the 
window automatically. See ”Error! Reference source not found.” on page 
Error! Bookmark not defined. for information about the different way the Brain 
window can operate. 
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 Thought Pins 

 
Figure 11. Thought Pins in an Existing Brain 

The area at the top of the Plex, just below the Brain toolbar functions like a 
bulletin board on which you can “thumbtack” Thoughts you want to keep at your 
fingertips. These quick-access shortcuts to Thoughts are called “pins.” No matter 
where you are in the Plex, the pins remain visible.  

1. Right-click the Thought named Reminders, then click Create Pin on the 
context menu. 

2. Click any other Thought in the Plex. When you want to return to the 
Reminders Thought, click the Reminders pin to get there instantly. 

 Relationship Changes 

1. Create a new child of Tour named “Experiments.” (Drag from Tour’s child 
gate down a bit, type: Experiments and then press the Enter key.) 

2. Now you’ve decided that the Experiments Thought should really have an 
equal relationship with Tour, and not be one of its children—because you’ll 
use experimenting as much as touring to develop your Brain skills.  



 A Guided Tour of TheBrain 

Guided Tour of TheBrain 7  Used With Permission from TheBrain Technologies LP.   All rights reserved.  10 

 Drag Experiments up to the left side of the Plex so that it is level with Tour, 
then release the mouse button. 

 
Figure 12. Dragging a Thought to Change its Relationship 

 Tip: See the section beginning on page Error! Bookmark not defined. for 
details about changing Thought relationships. 

 This is a good place for a break if you’d like to take one. You can leave your 
Brain open or close the Brain window. Just start up TheBrain again when you’re 
ready to continue. 

Part 3: Find, Add Attachments, Link, and Delete Thoughts 

Itinerary: You’ll find Thoughts, add an attachment to a Thought, add a Web page 
to a Thought, use a Thought to open an application, link some Thoughts, and 
delete a Thought. 

 

Your Tour Brain should be on the screen, as you left it in Part 2. You’ll begin by 
creating a few more Thoughts for a little more scenery along the way. 

 

1. Create four new child Thoughts under PB Buddies: John; Jill; Fred; Ann 
(Drag from PB Buddies’ child gate, then type each name, separated by a 
semicolon, then press the Enter key.) 
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Figure 13. Four New Thoughts 

 PB Buddies should be the active Thought—you should see the rotating 
active Thought indicator behind the Thought and it should be in the middle 
of the Plex. 

2. Enter a Note for PB Buddies: We should compare Brains sometime 

3. Point the mouse at the Tour Thought and notice how the Note changes. 
Then point back to the active Thought and see how the Note reflects the 
Thought being pointed to. 

4. Click the Reminders pin up at the top of the Plex to go quickly to your 
Reminders Thought. 

 Instant Activation  

“Instant Activation” is a Brain feature that lets you quickly find a Thought by 
typing a few letters, and choosing from a list of “hits.” After you click the Thought 
of your choice, that Thought is automatically activated. 

Say you’re ready to work with Fred’s Thought—you want to add an attachment to 
it. With such a small Brain, you could click around and find it pretty quickly, or 
you could speed things up: 

1. Click in the Search field and type: f 

 
Figure 14. Instant Activation 

 Because you only have one Thought that begins with the letter “f,” it is 
found instantly. If other Thoughts begin with the same letter you will see 
them in the box. The more characters you type, the more finely-tuned your 
search will become. 
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2. Click on “Fred” in the one-item list above the Search field where you typed 
the “f.” Fred will be activated. 

3. Type the letter “j” in the Search field to activating Jill. Notice that the two 
Thoughts beginning with the letter “j” appear in the list. Activate Jill. 

 Tip: See the “Error! Reference source not found.” section beginning on page 
Error! Bookmark not defined. for details about more complex searching and 
the “Error! Reference source not found.” section on page Error! Bookmark 
not defined. for more on cruising around your Brain.  

 Attachments 

1. Back to Fred. Activate Fred by clicking his Thought. 

2. Click the Add Attachment button in the Thought tab of the Tools window. 

 
Figure 15. Add an Attachment 

3. You can add an existing file or you can create a new one. For now, select 
an existing file on your computer. To do so, click the Link to File button. 

4. Navigate to any file on your computer, then click the Open button to attach 
it to the active Thought. 

 Notice that the filename appears in the Thought tab’s list section. Now you 
can click on it at any time to open the file. You might use this function to 
add a photo of Fred, or a file you’re collaborating on, or notes about a 
project you’re completing together. 
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 Web Page Thoughts 

1. Activate the John Thought. 

2. Open your Internet browser and navigate to a Web page of your choice. 

3. Arrange the browser window and the Brain window so that you can see at 
least part of both of them. 

4. Drag from the address bar icon in your browser to the active Thought 
(John), then release the mouse button. 

 
Figure 16. Inserting a Web Page as an Attachment 

A link to the Web page will be added to the attachment list in the Thought tool 
and you can launch the page by double-clicking on it whenever John is the active 
Thought. Or, you can single-click the icon in the Thought whenever it is visible in 
the Plex, whether John is the active Thought or not.  

 Tip: If you want to create a new Thought for the Web page instead of adding it to 
existing Thought, just drag and drop the page icon to a blank area of the Plex 
and a child Thought will be created. See the “Error! Reference source not 
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found.” section beginning on page Error! Bookmark not defined. for details 
about attachments. 

 Creating Attachments from a Thought 

1. Activate the New Brain Ideas Thought by typing an “n” in the Search field 
and then clicking on “New Brain Ideas” in the list. 

2. Click the Add Attachment button in the Thought tool. 

3. Click Microsoft Office Word Document (assuming this application is 
installed on your computer—if not, select any other application in the list). 
The new document will be named “New Brain Ideas,” matching the active 
Thought. 

  

If you are not using Windows, there will not be any automatically created 
file types to select from. To create files from within TheBrain, you’ll need to 
add some file templates first: 

 Click the Templates… button to open the folder where templates are 
stored, then copy empty files of the types you want to be able to create 
from within TheBrain into the folder.  

 When you are done, click the Add Attachment button again and chose 
one of the templates you added. 

Once you select a file type, two things will happen:  

 First, a new file will be created and added to the Thought (in this 
example, a Microsoft Word document named “New Brain Ideas”). 

 Second, the file will be automatically opened so that you can work on it 
(in this case, starting Microsoft Word).  

After you add content to the document and save it, it will be saved internally 
within your Brain. When you click on the Thought, the document will open 
again. 

4. Close the new document before moving on to the next section. 
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 Linking Thoughts 

One of the most powerful features of TheBrain is the ability to connect Thoughts 
to each other. Remember, you can connect any Thought to any other Thought. 
For example, say one of your PB Buddies, Ann, is full of ideas on how to use 
your Brain. You might want to link her to the New Brain Ideas Thought. 

1. Activate the New Brain Ideas Thought. 

2. Drag from the jump gate on the left side of New Brain Ideas as if you are 
going to create a new jump Thought and release the mouse button. 

 

3. Type the first few letters of the Thought you want to connect (Ann) in the 
Create Jump dialog box. Notice that the existing Thought is displayed in the 
list below. 

 

4. Select the existing Thought from the list and then click the check mark. 
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Figure 17. Jump Thought Linked to an Existing Thought 

Now that Ann is connected to New Brain Ideas, whenever you look at this 
Thought, her Thought will be just a click away. Also, when you are at Ann’s 
Thought, the New Brain Ideas Thought will be conveniently available. 

There are many ways to link existing Thoughts. The method above is convenient 
when the Thoughts you want to connect are not both visible, however if the 
Thoughts are both visible, you can simply draw the link between the two, starting 
from either one of the Thoughts’ gates. Both the Past Thought List below the 
Plex and the pins can be used for linking Thoughts visually. When you connect 
two Thoughts visually, the resulting relationship will be determined by which gate 
you selected to start the linking―it does not matter where you release the mouse 
button over the destination Thought. 

 Forgetting and Deleting Thoughts 

If you’ve entered a Thought in error or you simply don’t need to keep it around 
anymore, you can easily remove it from your Brain. TheBrain offers two ways to 
remove Thoughts―forgetting and deleting. When a Thought is forgotten, it can 
be remembered later if need be, however, deleting is permanent. 

Let’s forget the Thought Jill. 

1. Make PB Buddies the active Thought. 

2. Right-click the Jill Thought. 

3. Click the Forget command on the context menu. 

Jill disappears from the display. Now, if you want to show Jill again, turn on 
Forgotten Thoughts: 

 Click the Options menu, then click Show Forgotten Thoughts. 
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The Forgotten Thoughts dialog box can be used to permanently delete 
Thoughts or remember them. Just click the Thought, then click the Delete or 
Remember button. To turn off the display of forgotten Thoughts again, simply 
close the dialog box. 

 Tip: If you want to permanently delete a Thought without first forgetting it, hold 
down the Shift key as you right-click on it and then select the Delete command. 

Concluding Your Tour 

If you click the Home button in the Brain toolbar, your Brain should look 
something like this: 

 
Figure 18. Completed Tour 

Where to go from here? You can stay and experiment more with your Tour 
Brain, begin reviewing sections of interest throughout this guide, or dive into 
creating your own Brain. You may want to glance at some of the examples in 
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“Error! Reference source not found.,” beginning on page Error! Bookmark 
not defined., for more ideas—but you probably already have plenty of your own! 

 Tip: If you are ready to dive into beginning your own Brain, start by creating a 
few Thoughts for broad categories before you go to the detail level. For example, 
if your name is Ed, “Ed’s Brain” might be the name of your Brain (and your first 
Thought) and its first children might be Work, Family, Hobbies, and Friends. 

 This concludes your guided tour—-thanks for coming along! 
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